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ABSTRACT 

The concept of using renewable energy for power generation has experienced much 

attention with increasing costs of non-renewable sources.  The largest untapped 

renewable energy resource was in the form of the oceans and currents created by them.  It 

has been proven that many different concepts and designs are possible for this use and 

this study will focus on a bi-directional turbine created for this purpose. 

In the present study, the commercial CFD software ANSYS CFX was utilized to 

build a turbine map.  The basic turbine map was developed for a 25 blade bi-axial turbine 

under various flow conditions and the optimal efficiency for each flow condition was 

determined and a further analysis of the number of blades in the rotor was completed.  

The flow diagrams produced by the CFD analysis show that many improvements can still 

be made to the design in future iterations. 



 vi

THIS PAGE INTENTIONALLY LEFT BLANK 



 vii

TABLE OF CONTENTS 

I.  INTRODUCTION........................................................................................................1 

II.  PROBLEM DEFINITION ..........................................................................................7 

III.  TURBINE DESIGN AND MODELING ....................................................................9 
A.  GEOMETRY CONCEPTUALIZATION .....................................................9 
B.  COMPUTATIONAL FLUIDS MODEL/MESHING .................................10 
C.  PROBLEM SPECIFICATIONS AND BOUNDARY CONDITIONS ......13 
D.  RESULTS AND DISCUSSION ....................................................................15 

IV.  DESIGN IMPROVEMENTS ....................................................................................23 
A.  ROTOR CONFIGURATIONS .....................................................................23 
B.  ROTOR RECONFIGURATION RESULTS AND DISCUSSION ...........25 

V.  CONCLUSIONS AND RECOMMENDATIONS ...................................................27 

APPENDIX A.  MESH SETUP ....................................................................................29 

APPENDIX B.  RESULTS TABLES FOR 25 BLADE ROTOR ..............................31 

APPENDIX C.  VARIABLE BLADE RESULTS FOR 6 RPM SPEED ..................33 

APPENDIX D.  VARIABLE BLADE RESULTS FOR 9 RPM SPEED ..................35 

APPENDIX E.  ENVELOPE GEOMETRY GENERATION ..................................37 

APPENDIX F.  ROTOR GEOMETRY GENERATION ..........................................45 

LIST OF REFERENCES ......................................................................................................49 

BIBLIOGRAPHY ..................................................................................................................51 

INITIAL DISTRIBUTION LIST .........................................................................................53 

 



 viii

THIS PAGE INTENTIONALLY LEFT BLANK  



 ix

LIST OF FIGURES 

Figure 1  Annapolis Tidal Power Plant in Nova Scotia, Canada (From [4]) ....................2 
Figure 2  Northern Ireland’s Strangford Lough (From [5]) ..............................................3 
Figure 3  Atlantis AK1000 going to the Gulf of Kutch, India (From [6]) ........................4 
Figure 4  Lunar Energy in Wando Hoenggan Water Way, South Korea (From [7]) ........5 
Figure 5  Tidal Energy Pty Ltd supplied to Latin Power Group (From [8]) .....................6 
Figure 6  Clemson study of cascading Cross-Flow Turbine (From [3]) ...........................7 
Figure 7  Bi-Directional cross-flow tidal turbine ............................................................10 
Figure 8  Full mesh ..........................................................................................................12 
Figure 9  Close up of blade tips and envelope sheath .....................................................13 
Figure 10  Delta p versus mass flow rate for various turbine rotational speeds ................15 
Figure 11  Power versus mass flow rate for various turbine rotational speeds .................16 
Figure 12  Efficiency versus mass flow rate for various turbine rotational speeds ...........17 
Figure 13  Pressure contours for 6 rpm and inlet pressure of 2125 Pa ..............................18 
Figure 14  Velocity contours for 6 rpm at inlet pressure 2125 Pa .....................................19 
Figure 15  Rotor inlet velocity vector plot for 6 rpm at inlet pressure 2125 Pa ................20 
Figure 16  Rotor exit velocity vectors for 6 rpm at inlet pressure 2125 Pa .......................21 
Figure 17  Efficiency versus mass flow rate for various blade numbers at 9 rpm ............23 
Figure 18  Efficiency versus mass flow rate for various blade numbers at 6 rpm ............24 
Figure 19  Efficiency versus blade number for 6 rpm .......................................................25 
Figure 20  Full mesh setup and sizing ...............................................................................29 
Figure 21  Blade faces mesh setup and sizing ...................................................................30 
Figure 22  Blade tips mesh setup and sizing .....................................................................30 
Figure 23  Envelope design ...............................................................................................37 
Figure 24  Rough imagine of envelope .............................................................................39 
Figure 25  Finished curves before fillets ...........................................................................40 
Figure 26  Finished fillets ..................................................................................................41 
Figure 27  Using smart dimension to fix arc radii .............................................................42 
Figure 28  Rotor disc .........................................................................................................46 
Figure 29  Rotor blade shape .............................................................................................47 
 



 x

THIS PAGE INTENTIONALLY LEFT BLANK 



 xi

LIST OF TABLES 

Table 1.  Mesh statistics ..................................................................................................12 
Table 2.  Envelope sketch points ....................................................................................38 
Table 3.  Radius of curvature for envelope walls ...........................................................39 
Table 4.  Envelope fillet parameters ...............................................................................41 
Table 5.  Blade point parameters ....................................................................................46 
Table 6.  Rotor design arc parameters.............................................................................47 
Table 7.  Rotor fillet parameters .....................................................................................47 
 



 xii

THIS PAGE INTENTIONALLY LEFT BLANK 

  



 xiii

ACKNOWLEDGMENTS 

 I would like to express my appreciation to the following people whose valuable 

contribution aided to the completion of this thesis.   

 Professor Garth Hobson, his patient support and professional instruction 

throughout the entire process made my study possible. 

 Dr. Anthony Gannon’s analytical abilities aided in the creation of the CFD 

analysis and troubleshoot the problems that arose. 

 My girlfriend, Cecelia Arkenbout, who was infinitely patient and supportive 

throughout the many late nights of studies. 

 Finally, I would like to thank my family. My mother, Frances, who pushed to 

keep me focused.  My father, Keith, who kept things in perspective.  My brother, Aaron, 

who made sure I had fun while I enjoyed my time in Monterey.   

 



 xiv

THIS PAGE INTENTIONALLY LEFT BLANK 

 



 1

I. INTRODUCTION  

As renewable energy markets continue to grow some resources have been 

reconsidered as a viable source for electrical power generation.  Society has used the 

power found within moving water longer than it has been used any other power source.  

Wind, coal, and oil were used for their energy capabilities long after the first water 

powered turbines dating back to the 1st century BC in the Roman Empire [1].  Since that 

time, society’s needs for convenient energy and power has shifted to new technologies 

such as coal, oil, natural gas, and most recently nuclear power.  However, the ability of 

technology to keep up with the needs of society without putting unreasonable stress on 

the environment is not yet possible.  Innovative methods for power production must be 

exploited.  There are many possibilities in reverting to the origins of power production 

and focusing on the most powerful force on the planet, the oceans.   

Hydropower has always been a key resource throughout civilization.  Most towns 

and cities are built around waterways that were utilized for grain production and, as 

turbine technology developed, electric lighting.  Cross-flow turbines have been used for 

hydropower as an effective way of creating power from the water flow.  Many cascade 

design configurations have been tested [2], but a bi-directional cross-flow design has not 

been researched.  A cascade mono-directional cross-flow design developed by the 

University of Clemson [3] provided the basis of design to create a bi-directional turbine.  

By creating the bi-directional turbine, the system could be used in power dense oceans 

and tidal streams. 

Tidal flow has always been viewed as a great source for power generation. The 

problem has always been efficiently harnessing that power and getting it from source to 

consumer.  Over the last fifty years, several tidal turbine designs have been created by a 

variety of companies from around the world.  Many of these designs are either installed, 

or in the process of being installed.  The designs range from a tidal barrage, twin 

propellers, three-bladed propellers similar to wind turbines, ducted propellers, a vertical 

axis turbine, and many other variations of these designs. 
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A tidal barrage [4] is currently the most common form of tidal power 

augmentation and relies on a large dam that funnels the water into the generation plant 

and through a large turbine as the tide flows in and out. 

 

 

Figure 1 Annapolis Tidal Power Plant in Nova Scotia, Canada (From [4]) 
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A second design is a twin bladed propeller [5] that will be the world’s largest tidal 

device created by Marine Current Turbines.  It will turn at a rate of ten to twenty 

revolutions per minute and produce over 1.2 Megawatts of electricity. 

 

 

Figure 2 Northern Ireland’s Strangford Lough (From [5]) 
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A similar design is the three-bladed turbine produced by Atlantis Resources that is 

being installed on India’s west coast. It will be Asia’s first tidal turbine and its three-

bladed design will be installed as a turbine farm and expected to produce over 

200 Megawatts after development is complete [6]. 

 

 

Figure 3 Atlantis AK1000 going to the Gulf of Kutch, India (From [6]) 
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A ducted propeller design has been in production by Lunar Energy [7].  The 

company is installing a 300 turbine field in South Korea that will become the world’s 

largest tidal turbine installation.  Each unit is designed to produce one Megawatt of 

power, is 11.5 meters wide, and weighs over 2,500 tons.  The design is bi-directional 

which will not require mechanical realignment when the tide shifts.  This design feature 

is a significant power savings and maintenance advantage. 

 

 

Figure 4 Lunar Energy in Wando Hoenggan Water Way, South Korea (From [7]) 
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One of the newest designs is a vertical axis turbine instead of the traditional 

horizontal axis design.  This design is not bi-directional, but instead uses a pivot system 

to align it in the proper direction.  This Tidal Energy Pty Ltd company’s design is one of 

the most creative designs on the market as it does not rely on currently accepted design 

configurations. 

 

Figure 5 Tidal Energy Pty Ltd supplied to Latin Power Group (From [8]) 

After analysis of the current designs in the market and research of alternatives to 

the currently accepted design shapes, a new idea was formed by using a cross-flow tidal 

turbine with ducting.  The design was created so that it can be used in a bi-directional 

flow arrangement which eliminated the need for mechanical realignment between tidal 

streams.   

The objective of this study was a design to have been suitable for multiple 

installment locations and tidal current speeds.  Hence, a bi-directional design was 

conceptualized and analyzed at different rotational speeds to determine the highest 

efficiency for the given scenario.  Once efficiency results were established, a further 

analysis of the number of blades in the rotor were computed to determine the maximum 

efficiency possible at a given inlet pressure for the system. 
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II. PROBLEM DEFINITION 

The foundation for the project was outlined by a study completed at Clemson 

University [3] looking at cross-flow turbine efficiency in a cascade flow design.  In the 

study, the optimum efficiency was found for a cross-flow fan design in terms of number 

of blades, flow entry angle, and diameter ratio based on blade chord length.  The overall 

design was only based on the Clemson study because changing the flow direction from a 

cascading gravity fed mono-directional turbine to the bi-directional vertical axis design is 

significant.  The experimental data in the Clemson study was not applicable to this study 

because of those key differences.  The baseline and efficiency principles still applied, but 

the data was not comparable for this case given the nature of a turbine that can utilize bi-

directional flow.  

 

 

Figure 6 Clemson study of cascading Cross-Flow Turbine (From [3]) 
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III. TURBINE DESIGN AND MODELING 

A. GEOMETRY CONCEPTUALIZATION 

The design created for this project was based on the specifications provided by 

the Clemson paper [3] before adjustments were made in consideration of the flow.  The 

shape of the outer wall was designed to be similar to the Clemson inlet shape.  The inner 

wall shape was determined computationally by trial and error.  The flow inlet and outlet 

designs were created anti-symmetrically in order to utilize bi-directional flow.  The inlet 

shape was designed to be larger than the rotor area in order to direct the most water 

possible through the turbine.  The inlet and outlet areas had to be of equal in size and 

shape.  This was done to determine the best inlet size and flow shape to achieve 

maximum fluid momentum while not sacrificing efficiency when the tide shifts.  By 

creating the anti-symmetrical design, the blades always rotate the same direction which is 

essential to efficient power production at the generator.  The anti-symmetrical design and 

the rotational direction of the blades as fluid passed through the system is shown in 

Figure 7. 
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Figure 7 Bi-Directional cross-flow tidal turbine 

The rotor design was based on that of the Clemson study [3].  The gravity fed 

design that was analyzed by Clemson achieved a maximum efficiency with a 25 blade 

rotor.  This 25 blade design was the bases for the rotor.  Two of the most influential 

points of the design were the sharp angles at the point of fluid entry into the rotor from 

the envelope.  The key was to start the opening exactly in-line with the centroid of the 

rotors to achieve the maximum efficiency.   

B. COMPUTATIONAL FLUIDS MODEL/MESHING 

The mesh was produced with the sweep method on proximity and used edge 

sizing around the blades to ensure the concentration of points on the surfaces of the 

blades to produce the best resolution possible.  The sweep method was setup to sweep 

both domains together with an All Quad mesh type that utilized a number of divisions of 

3 with no bias.  During mesh construction, it was important to have enough points across 

the gap for the sheath going around the rotor domain.  This was done by using the 
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proximity setting for the mesh and setting the points across the gap to five.  Without this 

setting, the simulations failed due to singularities.  The relevance center was set to course 

which was acceptable because the model size made a finer mesh impractical.  The 

minimum size was set to 0.01 mm, maximum face size 0.05 m, and maximum size 0.05 

m.  Other settings remained in default condition.  The mesh settings can be viewed in 

Figure 19 in Appendix A. 

The edge sizing for the blades was imperative so that enough data can be gathered 

about the behavior of the fluid while flowing over the surface of the blades.  The edge 

sizing for the blade faces used 50 divisions with a bias factor of 30 and a bias shape that 

put the smaller sizing on the ends of the blades.  The blade tips also used edge sizing with 

10 divisions and no bias factor.  By concentrating data points around the surface of the 

blades accurate torque data was computed for the turbine. 
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Figure 8 Full mesh 

  Rotor Envelope

Nodes 185624 141712

Elements 134787 101223

Table 1.   Mesh statistics 
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Figure 9 Close up of blade tips and envelope sheath 

C. PROBLEM SPECIFICATIONS AND BOUNDARY CONDITIONS 

The simulation definition was created using ANSYS CFX-Pre.  The best 

measurements to determine the efficiency of the system were torque and the change in 

pressure between the inlet and outlet.  The Total Energy fluid model was selected 

because energy was generated within the turbine control volume.  For the purposes of this 

study, buoyancy and gravity were ignored.  An initial velocity condition of 1 meter per 

second provided a quicker convergence vice starting the flow at a standstill. 

Time-step selection was very important to the accuracy of the model.  The time-

step for the simulations of this study were set to 1 degree of rotation.  The Courant 

number at even slightly larger time-steps increased dramatically and less accurate data 

was the result.  With 1 degree time steps, the Courant number averaged 34.2, which was a 

reasonable value.  An average Courant number below 10 was preferable, but further 

reduction in time-steps increased simulation time significantly while the 1 degree time 

step provided sufficiently accurate data.   
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To have at least one complete rotation of the blades after quasi-equilibrium of the 

flow field, a total of 1,080 time-steps were calculated with 10 sub-iterations for each 

time-step.  For a speed of 6 revolutions per minute the simulation calculated 30 seconds 

of real time for a total of 3 full revolutions.  Other speeds required different time-step 

values, but 3 full revolutions were calculated with iterations at 1 degree of rotation 

regardless of blade speed. 

The model was tested at five different blade rotation speeds (1.5, 3, 6, 9, and 12 

rpm).  Each rotation speed was tested with different inlet gauge pressures from 33 Pascal 

to 34,000 Pascal.  In order to get a complete turbine map, some speeds needed higher or 

lower inlet pressures to produce the mass flow rate necessary for mapping. 
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D. RESULTS AND DISCUSSION 

Because the turbine was designed to be used in many locations with variable tidal 

patterns it was important to test the design under a variety of inlet conditions and 

rotational speeds.  The drop in pressure across the turbine was plotted (Figure 10) against 

the mass flow rate as a check to ensure that the code predicted the incompressible turbine 

performance correctly.  Other than small variations for different blade speeds the pressure 

lines were consistent throughout the simulation.  The result was confirmed and showed 

that the data was reasonable for the change in pressure readings. 

 

 

Figure 10 Delta p versus mass flow rate for various turbine rotational speeds 

The power produced in the system is determined by the flow rate of water moving 

through the turbine (Figure 11).  The power produced by the bi-directional turbine 

increases significantly as the mass flow rate increases, but due to the greater losses 

created by the stronger flow the efficiency actually decreases (Figure 12). 
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Figure 11 Power versus mass flow rate for various turbine rotational speeds 

An efficiency comparison was extremely useful to determine how the turbine 

would behave in various conditions of fluid flow and provided the key set of data that this 

study was to determine.  The efficiency of the system was determined by monitoring the 

mass averaged inlet pressure, outlet pressure, and output torque.  These were used in the 

following equations to determine the efficiency of a given set of conditions.  Volumetric 

flow rate was calculated in ANSYS CFX-Post using the expressions calculator.   
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Figure 12 Efficiency versus mass flow rate for various turbine rotational speeds 

From the analysis of the data (Figure 12), it was determined that the peak 

efficiency expected for this design configuration was around 26%.  This was compared to 

the theoretical maximum efficiency for a turbine extracting power from free fluid flow of 

59.3% (Ref. [9]).  The efficiency for a constant speed peaked at a different mass flow 

rate, but similar efficiency curves were created as the flow rate changed.  Tables in 

Appendix B show exact data values for the constant speed lines in the above plot. 

By analyzing the system further there were several positive and negative flow 

features for the design.  Through the analysis of pressure contours (Figure 13), velocity 

contour (Figure 14), and velocity vector profiles (Figure 15 and Figure 16) much 

information was gathered. 
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First, the pressure contour (Figure 13) was logical as the flow was observed 

passing from the inlet, through the turbine, and out of the end of the duct.  There existed a 

high pressure region on the concave faces of the blades on the positive torque generating 

side of the turbine with low pressure regions that existed on the back side of the blades.  

However, on the negative torque side of the rotor high pressure existed on the back of the 

blades with low pressure on the concave surfaces. 

 

 

Figure 13 Pressure contours for 6 rpm and inlet pressure of 2125 Pa 
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The velocity contour plot (Figure 14) provided a snapshot of fluid activity and 

local areas of significance.  When the fluid first enters the rotor, the transition of the first 

blade from a negative torque producing blade to a positive torque producing blade was 

clear.  The vortices created when the blades passed through the sheathed section of the 

envelope created negative torque as the fluid circulated from the concave side of one 

blade to the convex side of the other.  As the fluid exited the rotor, the high velocity 

regions showed the areas of significant pressure drop. 

 

 

Figure 14 Velocity contours for 6 rpm at inlet pressure 2125 Pa 
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The flow at the very top of the entrance area and the area at the exit were 

interesting because they affect much of the performance.  A closer look at each area 

showed regions of high velocity, this was associated with high total pressure losses. 

 

 

Figure 15 Rotor inlet velocity vector plot for 6 rpm at inlet pressure 2125 Pa 

At the point of entry (Figure 15), the fluid was highly active as it interacted with 

the blades and was entrained outside of the blades and followed the sheath of the 

envelope.  The design of the envelope and the entrance angle of the fluid caused a reverse 

torque to be created when the fluid wrapped around the entrance and made contact with 

the blade face.  The vortices within the blade gaps also developed a reverse torque on the 

system and thus reduced the efficiency.  A similar situation was also evident as the fluid 

exited the rotor.   
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Figure 16 Rotor exit velocity vectors for 6 rpm at inlet pressure 2125 Pa 

The flow path of the fluid again reversed the torque on the system causing a 

reduction in torque and thus power generation as seen in Figure 16. 
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IV. DESIGN IMPROVEMENTS 

A. ROTOR CONFIGURATIONS 

Turbine maps were developed for the 25 bladed rotor.  The number of blades on 

the rotor were adjusted to determine the optimum number of blades to produce maximum 

efficiency.  An analysis was conducted of the 9 rpm and 6 rpm blade speeds to determine 

the best number of blades.  Computations were done for 20 and 30 blade configurations 

in addition to the 25 blade study already completed.   

 

 

Figure 17 Efficiency versus mass flow rate for various blade numbers at 9 rpm 

The initial predictions (Figure 17) showed a clear increase in efficiency for higher 

blade numbers and hence further analysis was done for the highest efficiency for the 

6 revs/min case study in the form of 35, 40, and 45 blades.  

0

0.05

0.1

0.15

0.2

0.25

0.3

50 100 150 200 250 300 350

Ef
fi
ci
e
n
cy

Mass Flow Rate [kg/sec]

20 Blades

25 Blades

30 Blades



 24

 

Figure 18 Efficiency versus mass flow rate for various blade numbers at 6 rpm 

For the 6 revs/min case study (Figure 18), it was clear that as blade numbers 

increased the efficiency of the system also increased.  Based on the data calculated by 

CFD, the peak efficiency levels off at 29% for all three new cases of 35, 40, and 

45 blades.   

  

0.1

0.15

0.2

0.25

0.3

50 100 150 200 250 300 350

Ef
fi
ci
e
n
cy

Mass Flow Rate [kg/sec]

20 Blades

25 Blades

30 Blades

35 Blades

40 Blades

45 Blades



 25

B. ROTOR RECONFIGURATION RESULTS AND DISCUSSION 

The information from the study of varying the blade numbers proved that a higher 

blade count increased efficiency.  Theoretically, the efficiency should drop after too 

many blades are added resulting in excessive blockage.  However, up to the 45 blade 

case, a drop in efficiency had not been predicted (Figure 19) although the efficiency did 

level off.  

 

 

Figure 19 Efficiency versus blade number for 6 rpm 
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V. CONCLUSIONS AND RECOMMENDATIONS 

Based on this study, it is possible to use a bi-directional cross-flow turbine to 

produce rotational power from tidal energy.  The efficiency, at which the current design 

extracts the power at 26%, is low, however when compared to the Betz limit of 59.3% 

this concept is reasonable.  Therefore, the cross-flow tidal turbine technology is feasible, 

but a much higher efficiency is required before the system would be economically viable 

for large production.   

The optimum blade number is not calculated specifically, but will be found 

between thirty and forty blades.  This is based on the additional study of 6 rpm as forty-

five blades shows no improvement for efficiency when compared to the lower blade 

numbers.   

Three future design changes should be considered to improve the efficiency of the 

system based on this study.  The design changes for future studies are the entry and exit 

point of the flow going through the rotor domain, the length and shape of the blades, and 

the outside wall angle as the fluid is ducted into the blades. 

The entry point of flow at the entrance and exit of the rotor area can be shifted 

further around the circle in the clockwise direction which will direct more flow on the 

blade surface. This would increase flow speed while simultaneously producing a better 

angle of attack on the blades as they pass through the flow field.  Future designs altering 

this entry and exit point should be able to find the most efficient placement for the turbine 

as well as the entry angle that is most beneficial. 

The blade shape is a major factor on torque production by the fluid flow.  The 

increase or decrease of the radius of curvature of the blades will significantly impact the 

efficiency that a given flow condition can produce with the turbine.  As the flow passes 

through the blades, the first pass is on the concave side of the blade providing max torque 

for the turbine; however, the second pass is on the convex side of the blade which 

produces an opposing torque in the reverse direction.  There are many standard blade 

shapes which can be considered and will be researched prior to future iterations along 
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with unique configurations which may be more effective.  One idea is to flatten the blade.  

This would mostly eliminate the negative torque on the blades as the fluid flow exits.  It 

would also reduce eddies and vortices while providing a flat face for the fluid flow to 

produce positive torque while entering the turbine.  The high velocity zone at the exit will 

have a reduced effect with its producing of a local low pressure zone  

A third design change is the lowest section of the inlet duct.  If the wall were to 

have a more sloped design, the angle of the flow field is altered to a more optimal attack 

angle on the blades. This will produce more consistent torque production as the blades 

travel through the power section and will increase efficiency.  There is no foreseeable 

negative impact to adjusting this part of the design as it is inconsequential to the 

downstream portion of the turbine. 

Other changes for future studies can involve the mesh resolution. By refining the 

mesh, a more accurate picture inside the turbine will be produced. First, adding inflation 

layers on the blade surfaces will show more detailed boundary layer development.  

Second, a finer mesh around the contact point between the domains will provide a more 

accurate depiction of the fluid behavior as it transitions from envelope to rotor domains. 
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APPENDIX A. MESH SETUP  

 

Figure 20 Full mesh setup and sizing 
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Figure 21 Blade faces mesh setup and sizing 

 

Figure 22 Blade tips mesh setup and sizing 
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APPENDIX B. RESULTS TABLES FOR 25 BLADE ROTOR 

1.5 rpm                

Inlet 
Pressure 
[Pascal] 

Mass Flow Rate 
[kg/s]  Delta p [Pascal]  Calc. Eff.  Torque [N*m]  Power [W]

33  14.520  31.348  ‐0.028  ‐0.080  ‐0.013 

66.25  22.886  62.289  0.152  1.378  0.217 

132.5  35.678  122.958  0.240  6.700  1.052 

265  52.993  244.281  0.223  18.355  2.883 

531.25  78.021  485.965  0.189  45.503  7.148 

1062.5  112.717  967.885  0.147  102.346  16.076 

2125  158.873  1936.756  0.109  214.172  33.642 

4250  223.749  3876.024  0.082  452.652  71.102 

8500  317.908  7754.081  0.059  927.333  145.665 

17000  450.916  15506.567  0.042  1891.060  297.047 

25500  551.046  23258.099  0.035  2855.810  448.590 

34000  635.906  31009.740  0.030  3822.017  600.361 

3 rpm                

Inlet 
Pressure 
[Pascal] 

Mass Flow Rate 
[kg/s]  Delta p [Pascal]  Calc. Eff.  Torque [N*m]  Power [W]

66.25  18.533  63.281  ‐0.202  ‐0.755  ‐0.237 

132.5  29.159  125.790  ‐0.013  ‐0.148  ‐0.047 

265  46.044  248.859  0.166  6.068  1.906 

531.25  71.588  492.418  0.249  27.934  8.776 

1062.5  106.343  978.087  0.227  75.314  23.661 

2125  156.707  1941.759  0.192  185.699  58.339 

4250  226.006  3870.408  0.148  413.309  129.845 

8500  318.403  7745.212  0.110  863.460  271.264 

17000  447.239  15500.460  0.083  1823.882  572.989 

25500  549.036  23256.115  0.068  2774.352  871.588 

34000  635.050  31007.892  0.060  3735.409  1173.513 
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6 rpm                

Inlet 
Pressure 
[Pascal] 

Mass Flow Rate 
[kg/s]  Delta p [Pascal]  Calc. Eff.  Torque [N*m]  Power [W]

265  37.706  253.496  ‐0.216  ‐3.291  ‐2.068 

531.25  58.854  504.705  0.004  0.196  0.123 

1062.5  92.934  996.935  0.177  26.123  16.413 

2125  144.499  1967.663  0.254  114.988  72.249 

4250  212.284  3908.935  0.234  308.768  194.005 

8500  314.789  7756.228  0.196  759.788  477.389 

17000  452.642  15477.148  0.149  1666.580  1047.143 

25500  553.414  23215.163  0.126  2581.270  1621.860 

34000  637.396  30972.619  0.111  3477.561  2185.016 

9 rpm                

Inlet 
Pressure 
[Pascal] 

Mass Flow Rate 
[kg/s]  Delta p [Pascal]  Calc. Eff.  Torque [N*m]  Power [W]

531.25  53.956  507.053  ‐0.266  ‐7.722  ‐7.278 

1062.5  83.360  1009.006  ‐0.006  ‐0.498  ‐0.470 

2125  130.917  1994.701  0.159  44.004  41.473 

4250  202.425  3938.887  0.257  217.383  204.879 

8500  299.936  7826.772  0.237  591.444  557.423 

17000  437.866  15543.353  0.202  1461.173  1377.124 

25500  545.478  23262.571  0.175  2355.950  2220.431 

34000  638.065  30954.982  0.158  3305.481  3115.342 

12 rpm                

Inlet 
Pressure 
[Pascal] 

Mass Flow Rate 
[kg/s]  Delta p [Pascal]  Calc. Eff.  Torque [N*m]  Power [W]

531.25  50.868  511.200  ‐1.076  ‐22.274  ‐27.990 

1062.5  75.399  1018.029  ‐0.274  ‐16.746  ‐21.044 

2125  117.445  2020.347  0.013  2.508  3.151 

4250  186.538  3984.848  0.188  111.145  139.669 

8500  289.078  7868.043  0.260  469.876  590.463 

17000  426.869  15627.935  0.236  1251.778  1573.030 

25500  539.048  23345.693  0.212  2119.120  2662.964 

34000  630.775  31026.065  0.196  3045.486  3827.071 
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APPENDIX C. VARIABLE BLADE RESULTS FOR 6 RPM SPEED 

20 Blades          

Inlet Pressure [Pascal] 
Mass Flow Rate 

[kg/sec]  Delta p [Pascal]  Torque (N*m)  Calc. Eff. 

1062.5  93.677  995.931  19.247  0.130 

2125  139.286  1976.812  93.452  0.213 

4250  212.911  3907.888  286.581  0.216 

8500  326.477  7713.458  729.789  0.182 

25 Blades          

Inlet Pressure [Pascal] 
Mass Flow Rate 

[kg/sec]  Delta p [Pascal]  Torque (N*m)  Calc. Eff. 

1062.5  92.934  996.935  26.123  0.177 

2125  144.499  1967.663  114.988  0.254 

4250  212.284  3908.935  308.768  0.234 

8500  314.789  7756.228  759.788  0.196 

30 Blades       

Inlet Pressure [Pascal] 
Mass Flow Rate 

[kg/sec]  Delta p [Pascal]  Torque (N*m)  Calc. Eff. 

1062.5  91.488  998.637  29.785  0.205 

2125  143.661  1968.994  129.120  0.287 

4250  213.217  3911.005  332.242  0.250 

8500  305.369  7800.779  758.748  0.200 

35 Blades       

Inlet Pressure [Pascal] 
Mass Flow Rate 

[kg/sec]  Delta p [Pascal]  Torque (N*m)  Calc. Eff. 

2125  141.742  1973.176  129.420  0.291 

40 Blades          

Inlet Pressure [Pascal] 
Mass Flow Rate 

[kg/sec]  Delta p [Pascal]  Torque (N*m)  Calc. Eff. 

2125  139.979  1977.124  127.433  0.289 

45 Blades          

Inlet Pressure [Pascal] 
Mass Flow Rate 

[kg/sec]  Delta p [Pascal]  Torque (N*m)  Calc. Eff. 

2125  139.286  1979.348  126.781  0.289 
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APPENDIX D. VARIABLE BLADE RESULTS FOR 9 RPM SPEED 

20 Blades             

Inlet Pressure [Pascal]  Mass Flow Rate [kg/sec] 
Delta p 
[Pascal]  Torque (N*m)  Calc. Eff. 

1062.5  82.014  1010.200 0.227  0.003 

2125  130.268  1995.067 27.793  0.101 

4250  197.982  3955.275 182.737  0.220 

8500  301.591  7819.617 548.801  0.219 

25 Blades             

Inlet Pressure [Pascal]  Mass Flow Rate [kg/sec] 
Delta p 
[Pascal]  Torque (N*m)  Calc. Eff. 

1062.5  83.360  1009.006 ‐0.498  ‐0.006 

2125  130.917  1994.701 44.004  0.159 

4250  202.425  3938.887 217.383  0.257 

8500  299.936  7826.772 591.444  0.237 

30 Blades             

Inlet Pressure [Pascal]  Mass Flow Rate [kg/sec] 
Delta p 
[Pascal]  Torque (N*m)  Calc. Eff. 

1062.5  79.704  1014.007 ‐1.558  ‐0.018 

2125  128.436  1999.510 49.071  0.180 

4250  197.982  3946.265 239.267  0.284 

8500  300.465  7826.774 650.477  0.261 
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APPENDIX E. ENVELOPE GEOMETRY GENERATION 

A. Launch SolidWorks 2010. 

1. In the SolidWorks Banner, Select File > New Project from the Main Menu 

and click on Part – a 3D representation of a single design component > 

OK.  

2. In the SolidWorks Banner, Select Tools > Options > Document Properties 

– Units.  Ensure that MKS (meter, kilogram, second) is selected. 

B. Draw 2D Envelope.  

 

Figure 23 Envelope design 

1. Point Creation. 

a. Click on the blue Z-Plane arrow in the bottom left of the window. 

b. Right click on the Front Plane in the design tree on the left side of the 

window and choose the Sketch feature. 
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c. Click on the Point feature to sketch a point.  The bold locations in the 

table are to be fixed. This is done by clicking the Fix icon while inputting 

the points.   

 

Point
X 

Parameter 
Y 

Parameter 
1 -1.5 -1 
2 -1.5 -2.75 
3 1.5 -2.75 
4 1.5 -2.5 
5 0 -1 
6 0.9 -0.45 
7 1.5 1 
8 1.5 2.75 
9 -1.5 2.75 

10 -1.5 2.5 
11 0 1 
12 -0.9 0.45 

Table 2.   Envelope sketch points 

2. Draw lines connecting the points. 

a. Connect the following points together with the Line feature.  

i. 1 > 2 , 2 > 3 , 3 > 4 

ii. 7 > 8 , 8 > 9 , 9 > 10 

b. Connect the following points together with the Three Point Arc feature. 

i. 4 > 5 , 5 > 6 , 6 > 7 

ii. 10 > 11 , 11 > 12 , 12 > 13 
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Figure 24 Rough imagine of envelope 

3. Correct the shape of each arc by selecting the arc individually and changing 

the input to look like the Table: 

 

Curves 
Radius 

(m) 
1 4 
2 1 
3 2 
4 4 
5 1 
6 2 

Table 3.   Radius of curvature for envelope walls 
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Figure 25 Finished curves before fillets 
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4. Soften the edges of the curves by adding a Fillet at the important junctures. 

a. Click the Fillet feature. While holding down the CTRL key, select both 

lines on either side of the connections enumerated above. Once selected, 

enter the Fillet Parameters as listed in the table.  

 

Fillet 
Fillet Parameter 

(m) 
1 0.1 
2 0.02 
3 0.02 
4 0.1 
5 0.02 
6 0.02 

Table 4.   Envelope fillet parameters 

Once Fillets have been completed the figure will appear as in the Figure. 
 

 

Figure 26 Finished fillets 
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5. Ensure proper radii of arcs by using the Smart Dimension feature. Use the 

feature on the two shortest segments of arc to ensure a Radii equal to 1m. 

Next, make sure there is a 0.45m distance between the origin and each fillet 

centroid as it appears in the figure. 

 

 

Figure 27 Using smart dimension to fix arc radii 

Complete the sketch by clicking Accept Sketch. 

 

C. Extrude the sketch into 3D. 

1. In the Explorer Bar click the Features tab > Extruded Boss/Base (make sure 

that Sketch 1 is selected before you click on the Extruded Boss/Base button). 

2. For the thickness enter 0.1 meters. Click the green check mark to accept. 
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D. Design the center of the envelope for the rotor. 

1. In the Design Tree, click Front Plane. In the Explorer Bar, click the Sketch 

tab > Sketch. 

2. A new item should appear in the Design Tree called sketch2.   

3. Click the Circle feature from the explorer bar and create a circle about the 

origin with radius equal to 0.99 meters. Click the green check to accept. 

4. Click Accept in the top right corner of the layout. 

 

E. Make a cut out of the Envelope with sketch2. 

1. With sketch2 selected click on the Features tab in the Explorer Bar and then 

Extruded Cut. 

2. Change the distance measure to 0.1 meters. A yellow circle should appear in 

the middle of the envelope where sketch2 exists.  If this is not the case change 

the direction of the cut so that the yellow circle appears.  Click the green 

check mark.   

 

F. Save the file as Envelope.sldprt. Then select Save As and save it a second time 

as a Parasolid file named Envelope.x_t. 
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APPENDIX F. ROTOR GEOMETRY GENERATION 

A. Launch SolidWorks 2010. 

1. In the SolidWorks Banner, Select File > New Project from the Main Menu 

and click on Part – a 3D representation of a single design component > 

OK.  

2. In the SolidWorks Banner, Select Tools > Options > Document Properties 

– Units.  Ensure that MKS (meter, kilogram, second) is selected. 

B. Draw 2D Rotor.  

1. Disc Creation 

a. Click on the blue Z-Plane arrow in the bottom left of the window. 

b. Right click on the Front Plane in the design tree on the left side of the 

window and choose the Sketch feature. 

c. Click on the Draw a Circle feature.  Make the circle have a radius of 

1m. Click the green check mark and click Exit Sketch. 

C. Extrude the sketch into 3D. 

1. In the Explorer Bar click the Features tab > Extruded Boss/Base (make sure 

that Sketch 1 is selected before you click on the Extruded Boss/Base button). 

2. For the thickness enter 0.1 meters. Click the green check mark to accept. 



 46

 

Figure 28 Rotor disc 

D. Blade Creation. 

1. Click on the blue Z-Plane arrow in the bottom left of the window. 

2. Right click on the Front Plane in the design tree on the left side of the 

window and choose the Sketch feature. 

3. Click on the Point feature to sketch a point.  Both points are to be fixed. 

This is done by clicking the Fix icon while inputting the points.   

 

Point  X Parameter (m)  Y Parameter (m) 

1  0  0.7 

2  0  0.95 

Table 5.   Blade point parameters 

a. Draw 3-point arcs connecting the two points. 

b. Connect the two points together with the 3-point arc. Set the radius to 

0.2m 

c. Connect the two points together again with the 3-point arc. Set the 

radius to 0.3m 
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3‐Point 
Arc 

Radius 
(m) 

1  0.2 

2  0.3 

Table 6.   Rotor design arc parameters 

 

Figure 29 Rotor blade shape 

4. Soften the edges of the curves by adding a Fillet at the important 

junctures. 

a. Click the Fillet feature. While holding down the CTRL key, select 

both lines on either side of the connections enumerated above. Once 

selected, enter the Fillet Parameters as listed in the table.  

 

Fillet 
Fillet Parameter 

(m) 

1  0.0005 

2  0.0005 

Table 7.   Rotor fillet parameters 
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5. Create a Circular Sketch Pattern 

a. Left click the mouse button and drag over the entire sketch before 

releasing the left button. The sketch should be highlighted in blue. 

b. On the tool bar above the sketch click the pull down tab next to Linear 

Sketch Pattern. Select Circular Sketch Pattern. 

c. For number of occurrences enter 25 and click the green checkmark. 

Exit the sketch. 

 

E. Make a cut out of the Envelope with sketch2. 

3. With sketch2 selected click on the Features tab in the Explorer Bar and then 

Extruded Cut. 

4. Change the distance measure to 0.1 meters. Blades should appear cut through 

the disc where sketch2 exists.  If this is not the case change the direction of 

the cut so that the yellow blades appear.  Click the green check mark.   

 

F. Save the file as Rotor.sldprt. Then select Save As and save it a second time as a 

Parasolid file named Rotor.x_t. 
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